Interpreting Digital Images

Teacher’s Guide

July, 2004 Edition

Created by John Pickle and Jacqueline Kirtley

Contents

Introduction................................... 3
Description of Activities ................. 4
Activity 1: Three-Color Light .......... 7
Activity 2: Pictures and Colors ..... 12
Activity 3: Exploring & Measuring Light ....................... 17
Activity 4: Displaying Invisible Light ....................... 19
Activity 5: Using Analysis Tools... 23
Activity 6: Satellite Analysis ......... 27

Appendix:
Software Settings .................. 30
To set both colors and screen size: .............. 30
MixingColor ............................ 30
TriColor .................................. 31
Game_TriColor ....................... 31
Report_TriColor ..................... 32
PixelView ................................. 32
ColorPicture ........................... 33
MergePictures ........................ 34
SplitColors ............................. 34
ImageAnalysis ....................... 36
FalseColor ............................. 39
SurfaceType ............................ 40
LandSatAnalysis ................. 41
VegetationAnalysis ............... 45
Acknowledgements ............. 47
Interpreting Digital Images (IDI) is a part of the Global Systems Science (GSS) curriculum materials. 
http://lhs.berkeley.edu/GSS/

Copyright 2003 by the Regents of the University of California. All rights reserved.

IDI is a joint project of the Museum of Science, Boston and Lawrence Hall of Science
Introduction

This Interpreting Digital Images (IDI) teacher guide has materials for teachers and answers to questions in the student booklet. The student booklet is available as a separate document. Each activity is designed to take one class period of 45 minutes. However, some of the concepts are complicated. Extra classes would provide greater familiarity with the fundamental concepts. There are suggested extensions for additional classes.

Goals

A picture is worth a thousand words—and a million data points if one knows how to manipulate the image. The goals of IDI are to explore concepts and develop skills in analyzing a wide range of digital images. The six activities in IDI are designed to isolate and then integrate key concepts and skills in order to learn to manipulate, analyze, and interpret the data displayed in digital images. Software programs and hands-on activities have been designed to develop concrete understanding of color, light, and imagery. IDI supports scientific explorations related to the Global Systems Science high school curriculum (http://lhs.berkeley.edu/gss).

We are firmly entrenched in an era of technology that is generating huge volumes of data that require rapid and thorough processing of digital imagery. For example, earth-orbiting satellites have dramatically expanded our observations and understanding of our ever-changing planet. Satellite imagery is one of the most powerful tools available to global systems scientists who are striving to understand Earth’s changing ecosystems and the consequences of land-use policies and practices. The visualization and analysis tools provided may be applied to a wide array of digital imagery and graphical data available either on the Internet or collected with a camera.

How to Use These Materials

The six activities may be grouped into three units:

Unit 1—Explore critical concepts in color, imagery, and light;
Unit 2—Develop skills in manipulating and analyzing satellite imagery; and
Unit 3—Apply the concepts and skills to interpreting satellite imagery.

The appendix contains valuable details on how the IDI software modules work, and is in essence a technical manual for the software.

See the flow diagram illustrating the recommended sequence of the software components and the table summarizing each program that follow.

<table>
<thead>
<tr>
<th>Unit 1</th>
<th>Unit 2</th>
<th>Unit 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Goal:</strong> Explore concepts in color, imagery, and light</td>
<td><strong>Goal:</strong> Develop skills in manipulating and analyzing digital imagery</td>
<td><strong>Goal:</strong> Apply the concepts and skills to interpreting digital imagery</td>
</tr>
<tr>
<td><strong>Activity 1:</strong> Three-Color Light</td>
<td><strong>Activity 4:</strong> Displaying Invisible Light</td>
<td><strong>Activity 6:</strong> Digital Image Analysis</td>
</tr>
<tr>
<td><strong>Activity 2:</strong> Pictures and Colors</td>
<td><strong>Activity 5:</strong> Using Analysis Tools</td>
<td></td>
</tr>
<tr>
<td><strong>Activity 3:</strong> Exploring and Measuring Light</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Description of Activities

1) **Three-Color Light** explores how computers display millions of different colors with combinations of just three colors: red, green and blue. This concept is critical to grasp. Most people’s understanding of colors comes from working with paints, and they confuse mixing paints with mixing light.

   Key Software: TriColor, Game_TriColor
   Auxiliary Software: MixingColor, Report_TriColor

2) **Pictures and Colors** illustrates how a color picture on a computer screen is made up of tiny pixels, each of which has color defined by a combination of the three primary colors of light. Using familiar images, students see how the same picture would look with a few very large pixels or with a large number of very small pixels. This leads to the idea of image resolution. They also manipulate images to separate and change the contributions of each color component within the picture. They learn that an image has two separate aspects: measured intensities of light (sensor data) and the display of those measurements on a computer screen.

   Key Software: PixelView, ColorPicture
   Auxiliary Software: SplitColors, ImageAnalysis, MergePictures

3) **Exploring and Measuring Light** lets students use simple instruments to measure reflectance, absorption, transmission, and emission of light from various objects available in the classroom or around the school. Students measure the behavior of specific wavelengths of light (visible and infrared) with inexpensive, robust tools.

4) **Displaying Invisible Light** reveals how three sets of satellite measurements (sensor data) are displayed on a computer monitor. Students learn the meaning of false color, and how images may be interpreted by applying the knowledge of light, colors, and pixels. They identify different types of land surface covers (e.g. water, vegetation, exposed rock and soil, and snow) using the intensities of reflected infrared and visible red and green light as measured by Landsat satellites.

   Key Software: FalseColor

5) **Using Analysis Tools** introduces three satellite analysis tools. The *pixel* tool displays the intensity of red, green, and blue light for a selected pixel. The *line* tool helps to measure the length of selected features. The *visualization* tool quickly shows the contribution of each color in the image.

   Key Software: SurfaceType

6) **Digital Image Analysis** provides an opportunity to use advanced visualization and analysis tools on a wide array of digital images, including time series of Landsat images over the same location to explore how the Earth’s surface responds to natural or human-induced changes. Up to this point, students manually did at least one step of a calculation so they could understand the techniques. In this set of software, tools are automated, using the full power of the computer, to let students concentrate on exploring the information in digital images. Automated tools include graphing of data; toggling between visualizations; location/position, distance and area calculations; and pixel, line, and area tools. By using these tools, students may explore environmental issues scientifically and independently.

   Key Software: ImageAnalysis, VegetationAnalysis
   Auxiliary Software: LandSatAnalysis
Recommended Sequence for Software within the Three Units

### Software Summary Chart

<table>
<thead>
<tr>
<th>Software</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>MixingColor</td>
<td>Compare how colors mix using pigments and light</td>
</tr>
<tr>
<td>TriColor</td>
<td>Explore the colors created by mixing varying intensities of red, green, and blue light</td>
</tr>
<tr>
<td>Game_TriColor</td>
<td>Test your ability to identify the intensities of the red, green, and blue components of a color on the computer screen. Colors are created by playing another person or against the computer.</td>
</tr>
<tr>
<td>Report_TriColor</td>
<td>A report on how well students identify the intensities or red, green, and blue for 10 randomly generated colors is generated on-screen, in a text file, and printed for teacher or student use.</td>
</tr>
<tr>
<td>PixelView</td>
<td>Change the size of pixels for any digital picture (jpeg, gif, tiff, or pict)—called <em>pixelation</em></td>
</tr>
<tr>
<td>ColorPicture</td>
<td>Separate the red, green, and blue color components of any digital picture (jpeg, gif, tiff, or pict)</td>
</tr>
<tr>
<td>SplitColors</td>
<td><em>Advanced</em> manipulation of the red, green, and blue color components of any digital picture (jpeg, gif, tiff, or pict)</td>
</tr>
<tr>
<td>ImageAnalysis</td>
<td>Using <em>advanced</em> tools, analyze the spatial and color information within any digital image (jpeg, gif, tiff, or pict)</td>
</tr>
<tr>
<td>MergePictures</td>
<td>Combine time-lapse pictures onto one image</td>
</tr>
<tr>
<td>FalseColor</td>
<td>Similar to ColorPicture, manipulate the color display components of a Landsat image</td>
</tr>
<tr>
<td>SurfaceType</td>
<td>Using <em>simplified</em> tools, analyze the spatial and spectral information within a standard color composite Landsat image</td>
</tr>
<tr>
<td>VegetationAnalysis</td>
<td>Using <em>advanced</em> tools, study the spatial and spectral information within a time-series of Landsat images</td>
</tr>
<tr>
<td>LandSatAnalysis</td>
<td>Using <em>advanced</em> tools, analyze the spatial and spectral information within a standard color composite Landsat image</td>
</tr>
</tbody>
</table>
Activity 1: Three-Color Light

Purpose
- To learn that red, green, and blue are the primary colors from which you can make a myriad of colors.
- To understand how computers and TVs display color.

Why?
Most people think of color in terms of pigments, and they need the opportunity and the time to explore how colors are made with light.

Materials
- Computer lab (in form of single computer with video projector or large TV monitor, computer for every pair of students, etc.)
- TriColor and Game_TriColor software (Extension: MixingColor and Report_TriColor software; Report_TriColor may be used as an assessment tool.)
- Worksheets: TriColor Creation Chart, TriColor Prediction Chart, and TriColor Reference Chart
- Optional: Colored pencils or paint to color in TriColor Reference Chart

Preparation
1. Load software applications onto all computers and/or server that will be used during class. See appendix to check required computer settings.
2. Photocopy worksheets for each student.

Student Investigation
There are four steps within this activity:
1. Using the TriColor Creation Chart and TriColor software, students find the intensities of each of the three primary colors (red, green, and blue) needed to create specific new colors on the computer screen.
2. The TriColor Prediction chart turns things around: students are given primary color intensities and asked what color should they see.
3. Students independently explore and identify intensities of red, green, and blue in colors using Game_TriColor.
4. Students complete the Tri-Color Reference Chart as a tool to be used throughout the series of IDI activities.
### Tri-Color Creation Chart

Guess the color intensity combination to create the following colors:

<table>
<thead>
<tr>
<th></th>
<th>Red Intensity</th>
<th>Green Intensity</th>
<th>Blue Intensity</th>
<th>What would you call this color?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pure Red</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>Red</td>
</tr>
<tr>
<td>Pure Green</td>
<td>0</td>
<td>100</td>
<td>0</td>
<td>Light green</td>
</tr>
<tr>
<td>Pure Blue</td>
<td>0</td>
<td>0</td>
<td>100</td>
<td>Bright Blue</td>
</tr>
<tr>
<td>White</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>White</td>
</tr>
<tr>
<td>Black</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Black</td>
</tr>
<tr>
<td>Yellow</td>
<td>100</td>
<td>100</td>
<td>0</td>
<td>Yellow</td>
</tr>
<tr>
<td>Violet</td>
<td>50</td>
<td>25</td>
<td>75</td>
<td>Purple</td>
</tr>
<tr>
<td>Orange</td>
<td>100</td>
<td>50</td>
<td>0</td>
<td>Orange</td>
</tr>
<tr>
<td>Pink</td>
<td>100</td>
<td>80</td>
<td>80</td>
<td>Pink</td>
</tr>
</tbody>
</table>

### Tri-Color Prediction Chart

<table>
<thead>
<tr>
<th>Red Intensity Value</th>
<th>Green Intensity Value</th>
<th>Blue Intensity Value</th>
<th>What color do you guess this is?</th>
<th>What color do you see with TriColor?</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>100</td>
<td>0</td>
<td>Yellow</td>
<td>Yellow</td>
</tr>
<tr>
<td>0</td>
<td>100</td>
<td>100</td>
<td>Cyan</td>
<td>Cyan</td>
</tr>
<tr>
<td>100</td>
<td>0</td>
<td>100</td>
<td>Magenta</td>
<td>Magenta</td>
</tr>
<tr>
<td>75</td>
<td>75</td>
<td>75</td>
<td>Light Grey</td>
<td>Light Grey</td>
</tr>
<tr>
<td>50</td>
<td>50</td>
<td>50</td>
<td>Medium Grey</td>
<td>Medium Grey</td>
</tr>
<tr>
<td>25</td>
<td>25</td>
<td>25</td>
<td>Dark Grey</td>
<td>Dark Grey</td>
</tr>
<tr>
<td>100</td>
<td>50</td>
<td>50</td>
<td>Deep Pink</td>
<td>Deep Pink</td>
</tr>
<tr>
<td>100</td>
<td>50</td>
<td>0</td>
<td>Orange</td>
<td>Orange</td>
</tr>
<tr>
<td>100</td>
<td>0</td>
<td>50</td>
<td>Bright Raspberry*</td>
<td>Bright Raspberry*</td>
</tr>
<tr>
<td>50</td>
<td>100</td>
<td>50</td>
<td>Yellow Green</td>
<td>Yellow Green</td>
</tr>
<tr>
<td>0</td>
<td>100</td>
<td>50</td>
<td>Lime Green</td>
<td>Lime Green</td>
</tr>
<tr>
<td>0</td>
<td>50</td>
<td>100</td>
<td>Electric Blue</td>
<td>Electric Blue</td>
</tr>
<tr>
<td>75</td>
<td>50</td>
<td>25</td>
<td>Light Chocolate Brown</td>
<td>Light Chocolate Brown</td>
</tr>
</tbody>
</table>

*Naming colors often becomes very subjective, as you can see with our attempts at conveying the colors we see on our computer screens.*
Background

Color in Computer Images

Computers use intensities of the colors red, green, and blue to create a myriad of different colors on our monitors. Throughout this activity, students use percentages for each primary color intensity, ranged on a scale of 0 to 100 percent. However, most digital images use a binary scale with $2^8$ levels. Instead of 101 possible intensity values, there are $2^8$, or 256, possible intensity values for each color. These images can display over 16.8 million different colors.

Color Space

The RGB (red, green, blue) scheme is not the only scheme (called color space) in common use, though it is the one used in computer displays and most digital cameras and computer scanners. Color spaces are analogous to coordinate systems for maps. There are different map projections designed for specific functions, and no single projection fills all of the needs of cartographers. Similarly, one color space does not meet all of the needs of users of color.

Extensions

Testing Students’ Color Sensitivity

If your computer can be set to display millions of colors, then you might try the following experiments with your students to explore human perception of color. Starting at black (RGB = 0, 0, 0), incrementally change one color at a time and stop when the class sees a noticeable change in color. Compare the intensity values for each color. If your computer terminal produces an equal physical power of illumination for each color component (most CRT and active matrix LCD screens do), you should notice a brightness/color change quickest for the green channel, followed by red, and least noticeable are changes in blue. Compare the colors produced by RGB = (10, 0, 0), (0, 10, 0), and (0, 0, 10). Do all three colors have equally noticeable shades of the corresponding primary color? Note that the final colors you see on your computer are device dependent. Manufacturers of monitors and television screens do not produce a universal standard output of colors for the same RGB values.

<table>
<thead>
<tr>
<th>Color</th>
<th>Red Intensity Value</th>
<th>Green Intensity Value</th>
<th>Blue Intensity Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>White</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Red</td>
<td>100</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Yellow</td>
<td>100</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Green</td>
<td>0</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Cyan*</td>
<td>0</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Blue</td>
<td>0</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>Magenta*</td>
<td>100</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>Orange</td>
<td>100</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Purple</td>
<td>50</td>
<td>25</td>
<td>75</td>
</tr>
<tr>
<td>Brown</td>
<td>75</td>
<td>50</td>
<td>25</td>
</tr>
<tr>
<td>Pink</td>
<td>100</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>Light Gray</td>
<td>75</td>
<td>75</td>
<td>75</td>
</tr>
<tr>
<td>Medium Gray</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Dark Gray</td>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
</tbody>
</table>

* Students may be unfamiliar with these standard names. Provide definition during activity.
Next, try a similar experiment but starting at maximum intensity of a color (for example, RGB = 100, 0, 0 for red). Incrementally decrease the red intensity value to see if students find it easier to see color changes in red, green, or blue. Human eyes are sensitive to subtle changes in blue, despite blue not appearing as bright as green or red.

If you do these activities, the intensity of background light is very important. The brighter the background, the less sensitive your eyes will be to changes in computer display colors. Experiment with the room darkened and with all of the lights turned on to examine the perceived changes in color. There are many experiments that examine our perception of color when the object is surrounded by various colored backgrounds.

**Naming Colors**

Using mail-order clothing catalogs, such as Lands End, go through the pictures and descriptions/names of colors, try to match the colors with those using the TriColor application. Record the amount of red, green, and blue used to match the computer color with the catalog picture. Select a particular color, say green, and examine how "sage green" differs from "kelly green" in terms of intensities of red, green, and blue. If you have catalogs from several clothing manufacturers, find pictures of the same color, such as "sage green" to see how the colors actually differ from each other.

**Hands-On Color**

Explore the additive and subtractive color worlds by using food dyes, clear containers that can stack (such as a petri dish with its cap), an overhead projector, and a slide projector with colored slides (or a second overhead). Flashlights do not work as well since the intensity is not constant across the beam of light.

Make separate containers of red, yellow, green, and blue. Darken the room, and place the containers on the overhead projector. To illustrate the subtractive color process, stack the containers on top of each other. Each container removes all color except the color it transmits. To demonstrate with the additive color process, you need multiple light sources and beam the separate colors onto a white surface. When the colors intersect, the additive color is visible. If you use overheads, make a cardboard cutout the size of a single container so only the color is projected and not the surrounding white light.

**Definitions of Other Color Terms**

**Tint:** in pigment mixing (subtractive), colors achieved by the addition of white.

**Shade:** in pigment mixing (subtractive), colors achieved by the addition of black.

**Hue:** used in certain color spaces that place 3 color components around a circle, each separated from the next by 120°. Commonly, the 3 color components are red (located at 0°), green (located at 120°), and blue (located at 240°).

**Saturation:** this term describes the color intensity or "colorfulness". When saturation is 0, the color is colorless (gray), but at maximum value, the color is "saturated" for the remaining two color components of the color space.

**Value:** describes the color brightness or luminance. A zero value means there is no brightness and the color appears black. At maximum value, the color is at its brightest.

**Lightness:** is similar to value, except that at maximum lightness, the resulting color is white. Maximum color brightness occurs at half the maximum possible lightness.
Background Reading Materials

COLORCUBE web site has an excellent model for representing color ($30) that can be used in class. It also has many articles about theory of color in light and pigments.

http://www.colorcube.com/articles/articles.htm

For more information on color spaces, see:
http://www.inforamp.net/~poynton/ColorFAQ.html

How an eye "sees" color? http://www.howstuffworks.com/eye.htm

Basic properties of the electromagnetic spectrum.

http://imagers.gsfc.nasa.gov/ems/visible.html and
http://www.howstuffworks.com/light.htm

History of Cathode Ray Tubes (CRTs) and how primary color schemes were chosen.

http://inventors.about.com/library/inventors/bltelevision.htm

Dallas, Texas
1974

Dallas, Texas
1989

These images show the Dallas - Fort Worth metropolis, in northeast Texas. This city has grown significantly in recent decades, from 2,378,000 in 1970 to 3,776,000 by 1988. These images show the urban/suburban areas expanding into arable land in the countryside.

Satellite images
LM1029037007407190 (Landsat 1 MSS, 12 March 1974)
LM5027037008908190 (Landsat 5 MSS, 22 March 1989)
Activity 2: Pictures and Colors

Purpose

- To learn about pixels and resolution in computer images.
- To understand that an image has two aspects: the measurements of color/light intensities and the display of those measurements.
- Practice separating the primary colors in an image to study one at a time.
- To learn how atmospheric particles affect light in the atmosphere.

Why?

Even though we are bombarded with images each day, most people are not familiar with the abstract concepts of pixels and the two aspects of an image. Once these are familiar, manipulating images becomes easier.

Materials

- Computer lab
- Paper and pencil or word processor and printer for answering discussion questions.
- PixelView and ColorPicture software programs
- Digital Pictures: Mystery___#.jpg (pictures of unusual subjects) ColorCircles.jpg; MOSBuilding.jpg; AllSky.jpg (courtesy of Chuck Wilcox, Museum of Science, Boston, MA); Sunset.jpeg

Preparation

1. Load software applications and pictures onto all computers and/or server that will be used during class. See Appendix to check required computer settings.
2. Photocopy worksheets for each student.

Prerequisite for this activity: students should be familiar with the concept of electromagnetic spectrum and terms used to describe the spectrum, such as wavelength and frequency. This activity will focus on the energies of the visible part of the electromagnetic spectrum and with how all of the visible colors can be created by a combination of three colors: red, green, and blue.

Make sure that your students understand that pictures in TVs and computer displays are made up
Student Investigation

of tiny "picture elements" call pixels. Explain that the large color panels created in the first activity using both the TriColor and Game_Tricolor software programs represented a large pixel of a single color. It was large so the color could be seen easily. Most computer monitors and televisions screens have such small pixels, we cannot see them without a magnifying glass. Each tiny pixel of the computer screen is made up of closely packed dots or lines of red, green, and blue. Because these are so tiny and closely spaced, our eyes and brain process the three colors as one. The computer controls the intensities of each of these tiny sub-elements, creating each pixel's color. If you have enough magnifying glasses available, take a look at the computer screens and any other color display screens available in your classroom or school. There is a wide variety of technology used to make computer screens, ranging from cathode ray tubes (similar to that of televisions) to liquid crystal displays (LCDs).

Question 1. How does the resolution of an image affect what you can see? Why would you need more pixels to identify an image?

A: You can see greater detail with higher resolution due to a greater number of smaller pixels. A familiar image needs fewer details to make a correct identification. If an image is not familiar, more details are needed to identify an image.

Question 2. When could you identify an image with large pixels? How does resolution affect interpreting satellite images?

A: Easily identified objects are generally familiar and are very large relative to the pixel size. If features of interest are smaller than the pixel size, they will not be visible in the image.

Color of a Pixel

<table>
<thead>
<tr>
<th>Pixel</th>
<th>Red Intensity Value</th>
<th>Green Intensity Value</th>
<th>Blue Intensity Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper Left (UL)</td>
<td>13</td>
<td>25</td>
<td>50</td>
</tr>
<tr>
<td>Upper Right (UR)</td>
<td>22</td>
<td>45</td>
<td>75</td>
</tr>
<tr>
<td>Lower Left (LL)</td>
<td>55</td>
<td>45</td>
<td>60</td>
</tr>
<tr>
<td>Lower Right (LR)</td>
<td>75</td>
<td>30</td>
<td>40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pixel</th>
<th>Red Intensity Value</th>
<th>Green Intensity Value</th>
<th>Blue Intensity Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>UL – 1</td>
<td>10</td>
<td>26</td>
<td>45</td>
</tr>
<tr>
<td>UL – 2</td>
<td>15</td>
<td>20</td>
<td>55</td>
</tr>
<tr>
<td>UL – 3</td>
<td>20</td>
<td>22</td>
<td>47</td>
</tr>
<tr>
<td>UL – 4</td>
<td>7</td>
<td>32</td>
<td>53</td>
</tr>
<tr>
<td>Average for each:</td>
<td>13</td>
<td>25</td>
<td>50</td>
</tr>
</tbody>
</table>

The yellow rubber duck with the red, green, and blue intensities displayed differently on the computer screen.

Question 3. Compare the averages from the second chart to the values for the Upper Left pixel from the first chart. How are they alike? What do you expect would be average intensity values for the pixels in this same region if the resolution is 8x8?

A: The averages in the second chart match the color of the UL pixel in the first chart. The same should happen for the 8x8 resolution and UL-1 pixel. Watch for differences caused by rounding.
Question 4. Describe the colors you see in this picture. What color is the circle at the top? On the left? On the right? What other colors do you see in the picture?

Question 5. Change the combinations of Picture and Computer Display colors. What happens to the circle at the top? Can you make the picture have only one yellow circle?

A: The seven colors shift around the image as the picture and computer display colors are changed. To have one yellow circle, set:

- Green picture color ↔ Red computer color or Red picture color ↔ Red computer color
- Green picture color ↔ Green computer color

Question 6. What would this picture look like if we were blind to ALL colors except red—that is if we could see ONLY red light? How would the image look different in red than with all colors? Move your mouse over the picture to see the red intensity values of pixels throughout the image.

A: The sky would be dark since the red intensities are below 20%. The brick would be bright since the red intensities are greater than 75%.

Question 7. Change the view of this picture so that you can only see the red intensity values of the image file. To do this, set all three Picture Color choices to ‘Red’. What areas look bright in red light? Which areas look dark?

A: White represents the maximum intensity, black no intensity, and grays are intermediate values of red intensity. Now the sky is dark with wisps of clouds since the white clouds contain a high intensity of red (as well as green and blue). The brick is a light gray and the trees are dark gray. The red shirt on the man in the middle of the picture is now noticeably bright.

Question 8. Now view the picture with only the blue light. How does the picture look different? What details can you see better in the blue light? What is visible in the red light?

A: There is no visible detail in the sky. The edges of the bricks around the building are indistinguishable. The trees are dark gray, and the man in the red shirt is very hard to see.

Question 9. When all of the computer display colors show the red picture color, why does the image appear black and white? If your eyes were only able to see red, do you think that is what the world would look like?

A: Since the intensities of red range from 0 to 100%, the image will range from black to gray to white. If you could only see red, it would probably be like seeing the world in black and white since colors would have little meaning.

Question 10. Which of the three-color components (red, green, or blue) is dominant in the sky? Which color contributes the least intensity to the sky? See the contribution of a color by setting all of the computer display colors to a single picture color.

A: Blue is the dominant color in the sky and red the least contributing color.
Question 11. If the sky is blue because of tiny atmospheric particles scattering blue light, why is the Sun yellow? Hint: this is a good time to take a look back at the Tri-Color Reference Chart that you created in Part 1 [Activity 1].

Subtracting blue from white light leaves red and green, which is yellow.

Question 12. If the Sun appears to be yellow, why do clouds appear so white in the image? If you were riding on a satellite thousands of miles above the Earth, what would be the color of the “sky” (or outer space) and what would be the color of sunlight?

A: Clouds appear white since clouds reflect the yellow from the sun and the blue from the sky. Yellow + Blue = White.

In outer space, so little light is reflected by space that it would appear black and the sunlight would be white.

Question 13. Why is the color of the sky different at sunset from the middle of the day? What about the clouds and the Sun?

A: Sunrise and sunset often produce a yellow, orange, or red Sun in the sky. This is a result of the sunlight going through a greater amount of atmosphere, increasing the amount of scattering of the blue and green light by tiny atmospheric particles. Scattering favors the shorter wavelengths, violet and blue, so these are depleted from sunlight. Green light, wavelengths longer than blue light but shorter than red, scatters less than blue light, but the loss becomes evident when the sun is lower in the sky. This leaves a predominance of red light in the sunbeams at sunrise and sunset. As this red light reflects off clouds, the clouds take on a color of the remaining sunlight since this is the only light available to reflect off the white clouds.

Question 14. What color is the dominant color of the water? Where is the blue in this picture?

A: Red is the dominant color because it is reflecting the light from the Sun - the blue has been lost by scattering in the atmosphere farther away from the camera so it can’t be seen.

Extensions

Look at color pictures on the computer screen through colored filters. Try to reproduce what you see using the ColorPicture software control settings. This will help the students to physically see what the settings are doing to the pictures when the control buttons are changed.

As long as the image file is not too large (try to limit to a megabyte in size), the ColorPicture program can display any picture, which allows students to analyze pictures of their choice. Depending on the width and height, a portion of the picture may be cut off, but the program still functions so the remaining part of the image may be examined.
Background Reading Materials

Basics on the reflection of light and surface characteristics, including Java tutorials (spend time examining the useful information displayed in the tutorials since text is limited):
http://micro.magnet.fsu.edu/primer/lightandcolor/reflection.html

An excellent but slightly technical discussion with good graphics on the interaction of light and matter:

Discussion of the colors in the sky with pictures, but neglects to discuss green during sunrise/sunset:
http://cimss.ssec.wisc.edu/wxwise/bluesky.html

A complete discussion without pictures or graphics:

A complete discussion and graphics plus other related questions to sky optics, including why clouds become dark gray when thick:
http://www.usatoday.com/weather/askjack/wfaqsky.htm
Activity 3: Exploring & Measuring Light

Purpose

- To explore reflectance, transmission, absorption, and emission of light from various objects using light-sensitive probes attached to multimeters.
- To provide experiences working with infrared (IR) light.

Why?

Students need hands-on activities measuring the intensity of different wavelengths of light, especially since wavelengths we cannot see may or may not behave similarly as visible light.

Materials

One set of the following equipment for each team of two students

- multimeter with a voltmeter sensitive to voltages less than 2 volts
  - Digital display preferred over analog display
  - Cannot have autoranging feature
  - Example: Radioshack multimeter catalog number 22-810 ($19) or Jameco 119212 multimeter ($15)
- One red and one black wire with alligator clips on each end
- IR LED (Example: Radioshack 276-143c High-output Infrared LED T-13/4 case with bluish lens, cost $1.79)
- Red LED (Example: Radioshack 276-309 5mm Wide-Angle Red LED, 1.7 volt, 20 mA, 800 mcd, clear lens, cost $1.49)
- Worksheets
- 1.5 volt battery (AAA, AA, C) and either a battery holder or two copper wires
- Protractors
- Tape measures
- Cooler or thick cardboard box
- One warm and one cold source (either hot/cold heating pads, ice cubes, etc.)

Optional:

- digital camera or camcorder with LCD display and TV remote control.
- red laser with paper and tape.
- 1 inch segments of drinking straw that slide snuggly over LEDs.
- LEDs of other wavelengths/colors.
- Red permanent marker (such as a Sharpie marker).

Preparation

1. Check batteries on all multimeters prior to class.
2. Photocopy worksheets for each student.
3. Using a red permanent marker, color the longest wire of each LED.
Student Investigation

This activity allows exploration of reflectance, absorption, emission, and transmission of light from various objects. Students use simple instruments to measure how surfaces such as leaves, grass, water, dirt, rocks, pavement, and concrete reflect IR and red light. This experience is critical for learning to interpret satellite images since one of the primary ways to identify surface type with satellite measurements is to compare intensities of reflected IR and red light. It also conveys the idea of *ground truth*: verifying that data acquired in satellite images has characteristics that can also be measured on the ground.

<table>
<thead>
<tr>
<th>Surface Cover</th>
<th>Voltage of Red LED from sunlight</th>
<th>Voltage of Red LED from reflected light</th>
<th>Reflect Red Light [%]</th>
<th>Voltage of IR LED from sunlight</th>
<th>Voltage of IR LED from reflected light</th>
<th>Reflect IR Light [%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>Low</td>
<td></td>
<td></td>
<td>Low</td>
<td></td>
<td>Low</td>
</tr>
<tr>
<td>Green Growing Plant</td>
<td>Low to Moderate</td>
<td></td>
<td></td>
<td>High</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dirt/Soil</td>
<td>Low to Moderate</td>
<td></td>
<td></td>
<td>Low to Moderate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Concrete</td>
<td>Moderate</td>
<td></td>
<td></td>
<td>Moderate</td>
<td></td>
<td>Moderate</td>
</tr>
</tbody>
</table>
Activity 4: Displaying Invisible Light

Purpose

Learn to translate invisible electromagnetic energies into visible color displays. An image in which invisible electromagnetic energies are represented by computer display colors is known as a false color image.

Materials

- Computer lab
- FalseColor software program
- Satellite images:
  - MtStHelens_1973.jpeg
  - Rondonia_1975.jpeg
  - GreatSaltLakeUtah_1987.jpeg
  - OrlandoDisney_1986.jpeg

Note: all satellite images are from the United States Geological Survey’s (USGS) Earthshots web site at http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents

This web site contains over 40 case studies of changing surface features over time from around the world. Articles describe each of the studies, and satellite images are often available at different scales to examine the extent of the features, and many images have accompanying surface photographs to explore how the features look from an airplane or on the ground compared to images taken from a satellite. All of the satellite images, which are in jpeg (picture) format, can be downloaded onto your computer by either clicking and holding the mouse button or by right-clicking an advanced mouse on the satellite image and then saving the jpeg onto your computer. The program will run more efficiently if you save the file to the same folder that contains the FalseColor software application.

Preparation

1. Load software applications and pictures onto all computers and/or server that will be used during class. See appendix to check required computer settings.
2. Photocopy worksheets for each student.

Prerequisite for this activity: students should be familiar with the concept of electromagnetic spectrum and that there is electromagnetic energy invisible to our eyes. In particular, the energies adjacent to the visible part of the electromagnetic spectrum are infrared (at lower energy than the red end of the rainbow) and ultraviolet (at higher energies than the violet end of the rainbow). Students should also be familiar with how pictures on a computer display are produced by varying the intensities of red, green, and blue at very small points on the computer screen.
**Student Investigation**

**Question 1.** In this “blue-less” world, what colors would you expect to see? Do you see these all of these colors on this image? What colors are seen and what colors are missing?

_A: Without the ability to see blue, the colors that would be available would be combinations of only red and green: therefore, red, green, yellow, orange, and black would be possible. Missing will be blue, cyan, magenta, white, purple, and brown. Use the TriColor application to visualize the colors and shades that are possible and missing in this scenario._

**Question 2.** How does the intensity of the infrared data compare to that of the visible red and green light?

_A: Infrared behaves differently from visible light, and this image introduces several differences, but it does not provide definitive examples unless students either know the terrain and land cover surrounding Mt. St. Helens or are already familiar with the concepts of Landsat imagery. The snow on top Mt. St. Helens reflects most visible and infrared light; and the lake to the northeast of the volcano reflects little infrared or visible light. The remaining surfaces appear to be in two groups: one area that has intermediate intensity values of both infrared and visible light (these areas correspond primarily to exposed rock or soil), and one that has significantly greater infrared intensities compared to the visible light’s (these areas correspond to vegetated areas)._
Concluding Discussion

Review the following three-step process to interpret satellite images:

First, identify the colors of the satellite images and determine the contribution of red, green, and blue in making the colors. For instance, if yellow is observed in the image, there is an absence of blue in this portion of the image, and maximum intensity of red and green. If there is red in the image, then there is an absence of green and blue.

Second, you must know which satellite measurements’ wavelengths are mapped to the computer monitor’s colors. For instance, in these Landsat measurements from USGS, infrared measurements are placed in the computer display’s red color gun and measurements visible red and green are placed in the green and blue guns, respectively.

<table>
<thead>
<tr>
<th>Computer Display Color</th>
<th>Wavelength of Satellite Sensor Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard convention of color settings for Landsat imagery</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>Infrared</td>
</tr>
<tr>
<td>Green</td>
<td>Visible Red</td>
</tr>
<tr>
<td>Blue</td>
<td>Visible Green</td>
</tr>
</tbody>
</table>

Now, convert the computer display color into the contributions of the satellite sensor data. Using the example in the first step of identifying the observed colors, yellow on the computer image would indicate that there is an absence of visible green light and there is a maximum of infrared and visible red light. Red color would mean there is a maximum of infrared light but an absence of visible red and green light.

Third, relate the physical properties of the Earth’s features that would produce the observed patterns in the satellite sensor measurements. Landsat sensors measure the intensity of reflected electromagnetic energy from the surface of the Earth. So, the case of the yellow color in the computer displayed satellite image, the surface properties would reflect a high percentage of the Sun’s infrared and visible red light, but not reflect the visible green light. An observed red color in the computer image indicates the Earth’s surface at that location was reflecting a large amount of infrared but not of visible red and green. One of the goals of these activities is that students will learn to identify the types of surfaces that produce the most commonly observed colors in Landsat imagery.

In review, the three steps used to interpret satellite images follow:

- Identify the Colors in the Computer Display
- Relate Computer Colors to the Intensities of the 3 Sets of Satellite Sensor Data
- Relate the Satellite Data to the Physical Properties affecting the Measured Electromagnetic Energy
Extensions

There are many satellite images available at the USGS Earthshots web site that can be downloaded, each providing a rich example for students to explore and test their observations of infrared and visible light behavior. Students may go to the site and download their own images to use with the FalseColor software application.

Using a set of quality color filters, available through many science education material distributors, look at the world through these colored filters and have students record their observations or draw pictures of the new colors they see. In addition, write words on white or colored sheets of paper with crayon, and try to read with while viewing with different colored filters. Relate this to viewing a forest with a green or red filter.

Background Reading Materials

Discussion of false-color satellite images with good analogies:

http://imagers.gsfc.nasa.gov/ems/visible.html

Background reading available from the USGS Earthshots web site that covers Landsat imagery and surface characteristics:

http://edcwww.cr.usgs.gov/earthshots/slow/Help-GardenCity/Help-GardenCity

For viewing “true color” pictures taken from the Space Shuttle, which is helpful for students to gain a perspective of how the Earth looks from hundreds of miles above the ground before false-color images are considered:

Activity 5: Using Analysis Tools

Purpose

- Develop skills using basic satellite analysis and visualization tools

Materials

- Computer lab
- SurfaceType software program
- Satellite images:
  - MtStHelens_1973.jpeg, MtStHelens_1983.jpeg, MtStHelens_1996.jpeg

(Time series of Mt. St. Helens; one prior to its eruption, the second shortly after its eruption and the second 13 years later. Additional satellite images are available at the USGS Earthshots web site. For details on where and how to obtain these images, see the note in Activity 2 Materials section.)

Preparation

1. Load software applications and pictures onto all computers and/or server that will be used during class. See Appendix to check required computer settings.
2. Photocopy worksheets for each student.

Prerequisite for this activity: students should be familiar with the Red-Green-Blue color space and how false color images are used to visualize satellite data that often contains electromagnetic radiation invisible to humans.

Student Investigation

Question 1. What are the maximum and minimum x and y values you can find on the satellite image?

Maximum and minimum x values: 449 and 0, and the max/min y values: 323 and 0.

Question 2. Using the small white square, which represents one mile along each edge, in the lower left of the image, what is the number of pixels that represents 1 mile? Assuming the edge of one pixel touches the edge of the neighboring pixel, what is the size of one pixel? How many pixels represent 10 miles?

1 mile = 17 pixels. One pixel is 1/17 mile long. 170 pixels represent 10 miles.

Question 3. This image is oriented so that north is up and east is to the right. The east-to-west and north-to-south extents of the satellite image are how many miles? What is the distance from the upper-left corner to the lower-right corner of the image? Hint: you will need to use the Pythagorean Theorem if you are using the pixel analysis tool or you may use the line length in pixels output from the line analysis tool.

The satellite image 26.4 miles wide and 19 miles high, and has a diagonal distance of 32.5 miles (upper-left corner to the lower-right corner).
**Question 4.** What is the greatest distance across the snow cover observed on Mt. St. Helens in the lower left corner of the satellite image?

_A: The greatest distance across the snow cover observed on Mt. St. Helens is 2.6 miles._

**Question 5.** What is the greatest width across the lake observed in the left center of the satellite image? What is the greatest length across the lake?

_A: The greatest width across the lake is 1.4 miles and the greatest length is 2.2 miles._

**Question 6.** Using the line analysis tool, measure the diameter of caldera formed by the eruption. A caldera is the crater formed by a volcanic explosion or by the collapse of a volcanic cone. Find the location (x,y coordinates) of the center of the caldera and compare this to the location of the center of the volcano as seen in 1973. Does this explain the direction where most of the volcanic ash fell?

_A: The diameter of caldera is 1.3 miles. The caldera is north of the original peak of Mt. St. Helens, which would suggest that the eruptive blast would have gone toward the north._


<table>
<thead>
<tr>
<th>Location</th>
<th>Satellite Sensor Data</th>
<th>Vegetation Indices</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Y</td>
<td>Year</td>
<td>IR</td>
</tr>
<tr>
<td>313 180</td>
<td>1973</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1983</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td>0</td>
</tr>
<tr>
<td>321 167</td>
<td>1973</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1983</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td>54</td>
</tr>
<tr>
<td>273 257</td>
<td>1973</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>1983</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td>45</td>
</tr>
<tr>
<td>167 77</td>
<td>1973</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>1983</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td>100</td>
</tr>
<tr>
<td>185 89</td>
<td>1973</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>1983</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td>100</td>
</tr>
<tr>
<td>273 206</td>
<td>1973</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>1983</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>1996</td>
<td>41</td>
</tr>
</tbody>
</table>
**Question 7.** What are the maximum and minimum values possible for NDVI, provided you cannot divide the sum of the intensities when equal to zero. Based on the colors observed on the Landsat imagery of Mt. St. Helens, an NDVI value near the maximum value corresponds to what type of land surface cover? What about for NDVI values near 0? And what appears to produce NDVI values near the minimum value? Does this technique appear to work for the satellite images of Mt. St. Helens? Does it have problems?

**A:** The maximum and minimum values of NDVI are +1 and -1, respectively. An NDVI value near the maximum value corresponds to vegetation, near 0 then exposed rock and soil, and near the minimum value, water, ice or clouds, although snow can produce values of 0 when both the reflected intensities of infrared and red light are at a maximum. NDVI provides an adequate insight to the destruction of vegetation during the eruption and the reforestation that took place during the following years. The NDVI scheme does not provide information about the type of vegetation or other type of ground cover, and it is not completely calibrated to the amount of vegetation covering the ground - for instance, an NDVI value of +1 does not necessarily represent a 100% ground cover of vegetation.

**Extensions**

Mathematical challenges that accompany the pixel tool and false color images

**Challenge 1.** Create a color scheme in RGB color space where the intensity of all visible light produced colors range only from red to black. Black is produced when there is no light (i.e., zero intensity), and the maximum light intensity appears as the brightest red.

**Answer:** Let’s express the intensity of light as a percentage with 0% = no intensity and 100% = maximum intensity. Let’s further define the intensity of light as the average of the intensities of red, green, and blue light:

\[ I = \frac{I_{\text{red}} + I_{\text{green}} + I_{\text{blue}}}{3} \]

Where \( I_{\text{red}}, I_{\text{green}}, \) and \( I_{\text{blue}} \) can be determined using the pixel tool.

To have the colors range from red at maximum intensity and black at no intensity, set the values of RGB to \((I, 0, 0)\).

**Challenge 2.** Create a color scheme in which the colors range from white through gray shades to black. White is produced at maximum intensity of light, black when there is no intensity, and shades of gray are created with intermediate intensities.

**Answer:** As done in the previous mathematical challenge, express the intensity of light as a percentage with 0% = no intensity and 100% = maximum intensity, and define the intensity as the average of intensities of red, green, and blue light.

Remember that gray shades are produced when the intensity of red, green, and blue are equal. To create an image in shades of gray with white representing maximum intensity and black no intensity, set the values of RGB to \((I, I, I)\).

**Challenge 3.** Create a color scheme in which the colors range from black through gray shades to white. Black is produced at maximum intensity of light, white when there is no intensity, and shades of gray are created with intermediate intensities. Note that this is the opposite of the color scheme created in the Mathematical Challenge #2.

**Answer:** As done in the previous mathematical challenges, express the intensity of light as a percentage with 0% = no intensity and 100% = maximum intensity, and define the intensity as the average of intensities of red, green, and blue light.

To reverse the RGB scheme developed in the Mathematical Challenge #2, subtract the intensity value from the maximum intensity, which is 100%. The color scheme becomes RGB = \((100-I, 100-I, 100-I)\).
Challenge 4. Create a color scheme in which the colors range from red to white. Red is produced at maximum intensity of light, and white when there is no intensity.

Answer: As done in the previous mathematical challenges, express the intensity of light as a percentage with 0% = no intensity and 100% = maximum intensity, and define the intensity as the average of intensities of red, green, and blue light.

This is the trickiest of the challenges. Remember, red, which represents maximum intensity, is produced when RGB = 100, 0, 0; and white, which represents no intensity, is produced when RGB = 100, 100, 100. Notice that the value of red does not change for the two extreme cases, so RGB for all intensity values will look like 100, x, x.

This challenge also requires creating a scheme similar to that used in challenge #3: inverting the scale by subtracting the intensity from maximum intensity. Combining these two ideas creates an RGB scheme of 100, 100-I, 100-I.

Are there other color schemes students would like to create? Ask for ideas and work together to solve the challenges.

Independent Exploration

Students may explore incremental changes of the vegetation cover after the eruption using additional satellite images of Mt. St. Helens (1988 and 1992) available at

http://edcwww.cr.usgs.gov/earthshots/slow/MtStHelens/MtStHelens

After this activity, the following readings may provide better understanding of the activities as well as provide insight to the development of technology used in remote sensing.

Introduction to the History of Remote Sensing
http://edcwww.cr.usgs.gov/earthshots/slow/Help-GardenCity/remotesensing

Introduction to the Landsat series of satellites
http://edcwww.cr.usgs.gov/earthshots/slow/Help-GardenCity/Landsats

More detail on color interpretation of Landsat images

Discussion of vegetation identification using Landsat images
http://edcwww.cr.usgs.gov/earthshots/slow/Help-GardenCity/beyondimages

Background Reading Materials

An excellent introduction to the purpose of measuring vegetation cover and the basics of Landsat sensors and false-color imagery (there is additional material on other satellites and their sensors, so limit reading to the introduction and the following paragraphs on Landsat).

http://www.ae.utexas.edu/courses/ase389/midterm/curell/curell.html#intro

NASA’s introduction to remote sensing with a focus on Landsat, intended for advanced high school students to college students, see

http://rst.gsfc.nasa.gov/Overview.html

The on-line remote sensing tutorial developed by Canada Centre for Remote Sensing for seniors in high school or university students is at

Activity 6: Satellite Analysis

Purpose

Qualitative and quantitative analysis of vegetation changes caused by human interaction and natural events.

Materials

- Computer lab
- VegetationAnalysis software program
- Satellite images: (Time series of tropical rainforest in Rondonia, Brazil.)

Preparation

1. Load software applications and pictures onto all computers and/or server that will be used during class. See Appendix to check required computer settings.
2. Photocopy worksheets for each student.

Prerequisite for this activity: students should be familiar with the Red-Green-Blue color space, how false color images are used to visualize satellite data that often contains electromagnetic radiation invisible to humans, and the basics of vegetation indices, in particular, NDVI.

Student Investigation

Review with the students that in the 'Using Analysis Tools' activity, they examined how vegetation responded to a natural disaster. Humans did not destroy the vegetation, nor did they change the environment to slow the reforestation around Mt. St. Helens. In this activity, students will explore a common way in which tropical rainforests are being destroyed. With the satellite analysis tools that are provided, students can make detailed observations and draw significant conclusions based on their work.

Question 1. How do you think the rain forests of the globe are being destroyed? Is it by insects? Drought? Large-scale forest fires?

A: Although students may not know the mechanisms that are destroying tropical rain forest, many may have heard things from the news or other sources. It is commonly perceived that large fires are set and sweep across huge expanses of rain forest, similar to what is observed in the western United States during periods of drought. This does happen, but commonly, first roads appear, then people move in to settle, and they clear land for their homes and farms/gardens. This has a tremendous effect on the rain forests by creating breaks in the canopy which change the amount of sunlight reaching lower levels of the trees and ground, changing the humidity. Also, wind can now reach lower in the canopy, also changing the moisture levels, affecting plant growth and animal behavior.

Question 2. Do you think the United States lost much of its forests of the 1700s to 1800s in different ways compared to the rain forests?

A: Settlers moving west across the United States cleared land for various uses, such as lumber, farming, grazing, and residences, and as populations became established, forests were not reestablished. Is this any different than what is taking place in the rain forests? People are not destroying forests just for the sake of destruction, but rather, they are developing different uses for the land to meet their needs.
Question 3. What is the distance between roads that run west to east on the satellite image.

A: There is roughly 3 miles between the east/west roads.

Question 4. Draw a north-south line across these east-west roads and describe how the vegetation changes along the line. What are the average or mean NDVI values along the line for each of the 3 years? Compare you values to those observed in your class.

A: NDVI values appear to rebound slightly from 1986 to 1992 compared to 1975 to 1986.

Question 5. Create a box with corner #1 at x=66 and y=14 and corner #2 at x=295 and y=141. How many square miles does this box cover? How many pixels are within this box? What surface features appear in this box for the 1986 and 1992 images?

A: The box covers a village of 2.2 square miles and has 208 pixels.

What is the average of the NDVI values for all pixels within the box for each of the three images?

A: The average NDVI values of all pixels in 1975 is 0.84, in 1986 is -0.16, and in 1992 is 0.09.

Question 6. Create a box with corner #1 at x=66 and y=14 and corner #2 at x=295 and y=141. How many square miles does this box cover? How many pixels are within this box?

A: The box covers 304.5 square miles and has 29,440 pixels.

What is the average of the NDVI values for all pixels within the box for 1975 to 1992?

Change the min NDVI value (white box in upper right corner) to 0.6 and click the 'Run' button.

From the graph that results, what is the percent NDVI values within the box that fall within this range of NDVI values (0.6 to 1.0) from 1975 to 1992?

A: The average NDVI values within the area for 1975 is 0.87, in 1986 it is 0.75, and in 1992 is 0.82. The percent NDVI values between 0.6 and 1.0 for 1975 is 100%, in 1986 is 80%, and in 1992 is 86%.

Challenge. Use these satellite images and tools to describe how vegetation is changing in this section of Brazilian rainforest from 1975 to 1992. Examine the many features on the images, such as roads and villages, and explore how vegetation changes within and near these features. Based on these observations, what is your projection for the forest ground cover? In this projection, consider how well the NDVI identifies the type of vegetation covering the ground. Present your findings and your conclusions to the class.

A: The vegetation quickly depleted as the roads developed between 1975 to 1986. Either due to conservation efforts or as people established residences which allowed for vegetation to grow around the buildings (remember, we don't know the type of vegetation being identified by a high NDVI value), the lost of vegetation appeared to slow from 1986 to 1992 compared to 1975 to 1986.
Conclusion

Discuss the observations and conclusions of your classmates. 
Is there agreement among views? Are there conflicting opinions and data? Did your views of deforestation change after working with the satellite data? What additional data would help complete any questions you still have about deforestation in this area of Brazil?

Extensions

Go to the USGS Earthshots web site and examine several of the 40 available case studies. If a series of satellite images interests you, download the jpgs to the folder containing the remote sensing software. Explore the images with the VegetationAnalysis, LandsatAnalysis, or ImageAnalysis software programs. For information of the latter two programs, see the software technical manual.

Background Reading Materials

For a brief discussion of the deforestation in the Rondonia area, see http://edcwww.cr.usgs.gov/earthshots/slow/Rondonia/Rondonia

These images show rapid growth in city's cities and agricultural areas. Riyadh, capital of Saudi Arabia, grew from about a population of half million in 1972 to almost two million in 1990. Southeast of Riyadh, irrigation clearly increased due to the investment of part of Saudi Arabia's oil revenues in an effort to modernize agriculture. The smaller city of Buraydah, northwest of Riyadh, shows the same pattern of urban growth and agricultural development. From 1972 to 1986 the population of Buraydah almost tripled, from 60,000 to about 180,000 people.

Satellite images

LM1178043007226890 (Riyadh, Landsat 1 MSS, 24 September 1972)
LT4165043009024310 (Riyadh, Landsat 4 TM, 31 August 1990)
Appendix: Software Settings

- **Set computer monitors to a screen size of at least 1024 x 768.**
  MixingColor, Tricolor, and Game_TriColor also run on 800 x 600 resolution screens.
  
  NOTE: there are "small" versions of PixelView, ColorPicture, FalseColor, and SurfaceType which can run on computers with a screen size of 800 x 600. If you cannot use the higher resolution programs, use these versions.

  Only a portion of the computer activity will be seen using smaller screen dimensions.

- **Set computer colors for the maximum number of possible colors.**
  You will need to have at least several thousand colors available for these activities to produce the required range of colors.

**To set both colors and screen size:**

On PCs, use the display control settings (open the control settings and then the display file).

On Apple computers, click on the ‘Apple’ in the upper left corner of the screen, open the 'control panels' and then the 'monitors' file.

If using PCs, you will need to download and install **Quicktime** onto each computer.

This is Apple program is free at:

http://www.info.apple.com/usen/quicktime/

While installing the program using the menu-driven procedure, make sure the option for viewing 'jpegs' is selected using the appropriate button.

**Note:** all satellite images are from the United States Geological Survey’s (USGS) Earthshots web site at

http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents

This web site contains over 40 case studies of changing surface features over time from around the world. Articles describe each of the studies, and satellite images are often available at different scales to examine the extent of the features, and many images have accompanying surface photographs to explore how the features look from an airplane or on the ground compared to images taken from a satellite.

All of the satellite images, which are in jpeg (picture) format, can be downloaded onto your computer by either clicking and holding the mouse button or by right-clicking an advanced mouse on the satellite image and then saving the jpeg onto your computer.

**MixingColor**

**Purpose:** To visualize the difference between mixing color in pigment and light.

**Getting Started**

Select two colors by clicking on a color box in each of the two color palettes containing 6 colors.

Palette 1 sets the color of the left side of the box, and palette 2 sets the color for the right side of the box. The mixed color will appear between the two. The program uses equal proportions (intensity or amount of pigment) of each color when mixing.

The upper color box represents mixing colors of paint, and the lower box represents mixing colors of light.

The column of the color palettes represent the primary colors in pigment (cyan, magenta, and yellow) and in light (red, green, and blue).
**TriColor**

**Purpose:** Explore what colors are created by changing the intensities of red, green, and blue.

Intensities are defined within this software using whole numbers that range from 0 to 100%, which leads to a possible 1,030,302 colors (10^{13}).

An intensity of 0% indicates that there is no contribution of this particular color (red, green, or blue) in the observed color on the screen. A value of 100% means that all of the possible intensity of the color is present in the final display color.

Color intensities on most computer programs typically range by a factor of 2^8, which leads to values between 0 to 255, resulting in 16,777,216 colors (2^{24}). We felt that intensities in percent would be more intuitive to a larger audience of users than values ranging from 0-255.

**Getting Started**

There are 3 ways to change color intensity:

1) Single clicks on the up arrow increase intensity by one unit, and single clicks on the down arrow decrease color intensity by one unit.

2) Click and arrow and hold to quickly change values. Colors on the test screen will change immediately.

3) Click the cursor in each white box and type a whole number between 0 and 100%, or use the "tab" key to move between the boxes and type new values. When typing values, Click ‘Apply New Color Intensities’ to see what color is created with the three selected intensities of red, green, and blue.

**Game_TriColor**

**Purpose:** Allow fun and independent way to test your understanding of how many colors can be made using combinations of intensities of red, green, and blue light.

Users may either play against the computer (which generates a random "secret" color or against another person who secretly sets the color to be identified by the challenger.

The software keeps track of the number of guesses and correct color identifications, and provides hints for incorrect guesses. Three challenge levels provide users to select a level of difficulty appropriate for all talents and experience.

1. Select the level of challenge.
   - Easy (color intensities must match within 15% and a hint is given after guess)
   - Medium (color intensities must match within 10% and a hint is given after guess)
   - Hard (color intensities must within 5% and no hint is provided after guess)

2. Select opponent: ‘People’ or ‘Computer’
   - When this button is clicked after guesses have been made, the scores are automatically reset to zero.

3. Press ‘Set Secret Color’
   - When playing a person, a secret window will pop up. In this new window, enter intensity values in the red, green, and blue boxes. The person to guess the secret color should not watch the screen at this time!
   - When playing the computer, a random color is set automatically.

4. Set your guess color by entering intensity values in the red, green, and blue boxes.
   - While playing against the computer, clicking ‘Set Secret Color’ provides a new secret color without adding points to your score.

5. Press ‘Try Your Guess’ to see if your guessed color matches the secret color.
   - A hint is automatically displayed if the guess does not match the secret color. The hint shows that color intensities need to be increased or decreased.
6. Repeat until colors match.

After matching the secret color, you may continue playing or you may explore the many possible matched colors.

No guesses are charged for exploring these colors.

Pressing 'Show Answer' costs 10 guess points and the player must guess a new color.

At any time, you may select reset the score to zero by selecting 'Reset Score' in the 'File' menu.

For more information about colors and examples, click 'Basics of Color' in the 'Help' menu.

**Report_TriColor**

*Purpose:* Provide an assessment tool for teacher and student use that identifies the skills and concepts developed in modifying the intensities of red, green, and blue in creating a wide array of colors.

Users must match 10 randomly generated colors, and the software keeps track of the errors of guesses and generates a report available on-screen, in a text file, and printed for student portfolios. The statistics help identify how well students can match the intensities and the color proportions of the secret color, two critical steps in understanding color made on a computer screen.

To run this program, set the screen size to at least 800 x 600 and as many colors as possible.

After typing the student name or code assigned by the teacher into the opening window of the program and created a filename for the electronic report, users will be able to work on identifying the randomly generated colors.

1. Set the guess color by entering intensity values in the Red, Green, and Blue boxes.
2. Press 'Try Your Guess' to see if the guessed color matches the secret color.
   
   A hint is provided after incorrect guesses.
3. Repeat until colors match.
   
   A match occurs when the guessed intensities are within 15% units of the corresponding secret color. This means there are 29,791 possible matches.
4. The program continues until 10 colors have been matched. A report is generated on-screen and for printing. The electronic file provides a list of each guess for all 10 color challenges, as well as the output statistics.

**PixelView**

*Purpose:* Explore how a picture would appear using different size pixels.

This program does not zoom into a picture, rather, it creates different displays of the same picture by changing the size of the pixels.

Pictures on a computer screen are made up of unique tiles, or pixels, of color.

Picture elements or pixels are the smallest unit of a picture with the color appearing constant across the pixel.

The smaller the tiles, the more details you can see.

The color of a pixel is controlled by the combined intensities of red, green, and blue components.

**Getting Started**

Select a picture (a file ending with "*.jpeg", "*.gif", "*.tiff", or "*.pict") by clicking 'Select Picture'.

---

32 Global Systems Science Interpreting Digital Images—Teacher Guide
A menu will pop up and any image stored on the computer may be selected.

Ideally the program works on images that have 512 pixels in both the vertical and horizontal.

Images with significantly more pixels may be too large and an error message will be displayed.

Smaller images will have the edges filled with white in order to create a picture that is 512 x 512 pixels. This will distort the color of larger pixels adjacent to these edges since the white color will be averaged into the larger pixel’s color.

The first display of any picture will appear very blocky because only 4 pixels are used to create the picture.

To increase the number of pixels used to make the picture, click 'Create Picture with More Pixels’. The number of pixels increases by a factor of 4 with each click.

Click 'Create Picture with Fewer Pixels’ to see the picture with larger pixels.

The color of the larger pixels is the average color of the smaller pixels that lie within the border of the larger pixel.

To see the borders of pixels of different sizes, click on one of the options available in the menu button beneath the label 'Show Pixel Borders'.

Move the cursor across the picture, and the pixel being displayed will have a highlighted border.

The intensity of red, green, and blue that make up the pixel’s color will appear in text in the lower right of the window.

0% means that there is none of that color contributing to the pixel’s color.

100% means that all of that color is being used to make the pixel’s color.

**ColorPicture**

**Purpose:** To understand there are two components to a picture: the recorded or measured intensities of light coming from the subject being photographed and the intensities of the displayed colors on the computer screen.

The two do not have to match, and when they don’t, see how the image changes in appearance with this software.

**Getting Started**

Select a picture (a jpeg, gif, tiff, or pict file) by clicking 'Select Pictures'.

A menu will pop up and any image stored on the computer may be selected.

The first display of any picture will appear normal because the Picture’s Red, Green, and Blue data in the Computer Display’s Red, Green, and Blue colors, respectively.

Select which of the picture’s three primary colors the computer display’s RED, GREEN, and BLUE visualize. You may also show one primary color at a time or one picture color in all three of the computer’s primary colors. There are many combinations to try.

Each change is automatically displayed.

To see the original picture, click ‘Show Original Picture’.

Move the cursor across the picture, and the pixel being displayed will have a highlighted border.

The intensity of red, green, and blue that make up the pixel’s color will appear in text in the lower right of the window.

0% means that there is none of that color contributing to the pixel’s color.

100% means that all of that color is being used to make the pixel’s color.
MergePictures

*Purpose:* Create one image out of a time-lapse series of images

During our experimentation with using digital cameras as tools to study color and color change in our environment, we found that it is quite difficult to combine a time series of digital pictures into one image using existing imaging software. So we created this software that allows you to do this quickly and easily.

**Getting Started**

First, enter the number of images you will be combining in the white box at the top of the page.

You cannot change this value once the reading of images begins, so be accurate.

Next, click 'Select Pictures' to begin selecting JPEG, GIF, TIFF, or Pict images.

The program assumes that each picture is of identical size (same number of pixels in the vertical and horizontal) and will not work otherwise.

To save the merged image, go to the 'File' menu and select 'Save Image'.

Create a file name different from any used to create the image. The saved file will overwrite any file with the same name.

SplitColors

*Purpose:* This program gives you the freedom to explore how colors from an image can be modified to make very unusual variations of the original.

The program also attempts to provide the opportunity to understand why the image changed as it did by providing analysis tools and histograms of the color intensities of the original and resulting images.

**Getting Started**

First, Click 'Select Picture' to open a picture (a jpeg, gif, tiff, or pict file).

A menu will pop up that lets you find the file you would like to select.

**Basic Features**

Move the cursor across the picture, and the pixel being displayed will have a highlighted border.

The intensity of red, green, and blue that make up the pixel's color will appear in text in the lower right of the window.

0% means that there is none of that color contributing to the pixel's color.

100% means that all of that color is being used to make the pixel's color.

'Show Original Picture' opens a window containing the image with the original color settings.

This may be helpful when you try to understand how you created a strange new image.

Moving the cursor in this window or the one in the main window lets you see pixel colors of both the original and new images simultaneously while the pixel location in each image is highlighted.
‘Plot Histogram of Colors’ creates a graph of the frequency of color intensities within 5% increments observed in both the image being displayed and the original image.

For example, for a 500-pixel image, if there were 200 pixels with red intensity between 80 and 85%, the frequency is 200/500 or 40%.

Saving Images
To save your images, click on the ‘File’ menu at the top of the computer screen and select ‘Save Image’.

A pop up window will let you name your image and store it in the desired folder.

NOTE: make sure to give the saved file a different name from the original - it will delete the original!

Remapping Colors
This program allows you to display one color, such as green, in the computer’s red color.

To do this, locate the menu button associated with the Red computer display color. It should have “Red” displayed if you are working with a newly opening picture and select “Green”. Set the remaining picture colors to ‘None’.

Click ‘Apply New Colors to Picture’ and observe how the image changes.

You may display any color of the image in any of the computer’s colors (red, green, and blue).

‘Invert’ reverses the intensity of the selected color.

The most intense color will appear very dark on the image, and vice versa.

If you apply this to all three colors when mapped into corresponding colors, you create a color “negative” - what you get back from the photo shop when you take your film in for developing.

Checking the ‘Mask’ box changes the intensity of the image’s color that fall outside selected range to be set to 0 (zero).

If the box is unchecked, the color that was outside the selected range remains set to the original image’s color.

Stretch, Compress, and Shift of Color Intensities
You may want to display only a portion of the range of a color’s intensities, and display it in the same range of the computer’s color. Or you may display it however you would like - in a different color altogether, in the same range of values but more or less intense than before, or over a larger or smaller range than selected.

Use the color histogram plots to decide what ranges of colors you would like to focus on, and make your selection using the minimum and maximum value options in the top center of the window.

Either type the intensity values in the white boxes or use the small up and down arrows to change values.

To see how the image changes, click ‘Apply New Colors to Picture’.

Examples

Stretch: Display the Picture’s 20 to 50% red intensity in the Computer’s 0-100% red intensity range.

Compress: Display the Picture’s 0-100% red intensity in the Computer’s 80-100% red.

Shift: Display the Picture’s 20 to 50% red intensity in the Computer’s 70-100% red intensity range.
**ImageAnalysis**

**Purpose:** A picture may be worth a thousand words, but is it worth a thousand points of data?

With this tool, pictures become a valuable source of spatial and color data.

The software was designed to work on any digital image that is found on the Internet or that you have created with a digital camera.

**Getting Help**

There are many useful features to this program, and additional information is available in the ‘Help’ menu.

**Getting Started**

First, click on the button labeled ‘Select Image’.

At any time you may select a new digital image by clicking on the ‘Select New Image’ button.

Whenever you select a new image, all feature values are reset to default values.

After the image is selected, a window will pop up that asks you whether you can **calibrate** the size of pixels within the image. There are 4 options:

1) **Click the button ‘USGS Landsat’** if you are using a Landsat image from the USGS Earthshots web site. NOTE that if there is much white around the box that is part of the satellite image, the automated calibration may become confused. Check the results by measuring the scale box with the line tool. If the calculated distance is incorrect, run the ‘Scale Present in Image’ calibration method by rerunning the calibration by clicking the ‘Calibrate Scale Tools’ button.

2) **Click the button ‘Known Pixel Size’** if you know the size of the pixels, such as orthophotographs from aerial reconnaissance.

3) **Click the button ‘Scale Present in Image’** if there is a linear scale located in the image. This includes images taken with a camera in which a ruler, penny, or other object of known size is located next to the object you are interested in and the camera lens is parallel to the object of interest (not at a slant). Also, graphics of data with a distance scale, such as maps of ozone concentration over the United States that can be downloaded from the Internet, can use this calibration method.

4) **Click the button ‘None’** if there is no way to calibrate the scale of the pixels.

The first three options will provide guided instructions of what you need to enter. If you make a mistake in any of the steps, click on the button labeled ‘Calibrate Scale Tools’ to repeat the process. The program assumes that the pixels are square in shape so measuring the distance in one direction is applied to all directions. Manually Calibrate Scale Tools (Option 3)

A window will pop up in which you may draw a line along the scale within the image by moving the cursor onto the image.

Click on the beginning of the scale, which may be a ruler, a penny, or any object of known length.

Hold the mouse button and drag the cursor to the end of the scale. Release the mouse button.

A yellow line is drawn on the image marking where you clicked on the image and where you released the mouse button.

If the line does not match up exactly, either redraw the line or fine tune the start and stop positions of the line with the small arrows next to the x and y positions of the line end points, which are located below the image.

When satisfied with the fit of the line to the scale, enter the length of the scale in the white box below. Enter only the number, not the unit of the scale (such as inches or centimeters).
Click the ‘Done’ button when finished.

To re-run the calibration method click the ‘Calibrate Scale Tools’ button in the upper left of the main window.

Click the ‘None’ button if there is no way to know the size of the pixels in the image.

**Exploring Digital Images**

Use the menu button below the text ‘Display Tools’ to view different displays of the satellite image.

**Information on the Display Tools**

There are 12 automatically calculated enhancements to view the satellite image.

1) RGB = standard color composite of digital imagery in which the color intensities of red, green, and blue are displayed in the computer display’s red, green, and blue, respectively.

2) B&W = black and white image of the RGB image in which the average of the color intensity the image’s red, green, and blue is displayed equally in the computer display’s red, green, and blue.

3) Mask. A combination visualization enhancement and image analysis tool.

Display only those pixels that meet thresholds you select.

- Pixels meeting criteria are displayed as black.
- White pixels represent those that did not meet the criteria.
- Number of pixels meeting threshold are displayed.
- If pixel size is calibrated, area of highlighted pixels is calculated.

4-6) IR, Red, or Green (Gray). A gray shade image of only one of the image’s primary colors.

For example, a gray shade image of red displays the pixel’s red value in all three colors of the computer’s display.

Gray shade images allow viewing of intensities without biasing your sensitivity to red, green, or blue.

For example, if a pixel’s RGB values are 20%, 80%, and 30%, respectively, it will be displayed as 20%, 20%, 20% if the Red (gray) display is selected.

7-9) R v G, R v B, or G v B: For each pixel, display the difference between two color intensities.

The color of the greater value is displayed.

For example, suppose R v G display tool is selected. If a pixel’s RGB values are 20%, 80%, and 30%, respectively, the difference between red and green is 60% in favor of the green. The displayed color for that pixel will have RGB values of 0%, 60%, 0%.

Therefore, the brighter the color, the greater the difference between the two measurements, and the darker the color (or closer to black), the smaller the difference between the two measurements.

10-12) R v G, R v B, or G v B (normalized): Similar to 7-9 above, except that the difference of the color intensities is divided by the sum of the color intensities.

This provides a way to minimize the effects of shadows and indirect lighting within the image.

For example, suppose R v G (normalized) display tool is selected. If a pixel has RGB values of 40%, 80%, and 60%, respectively, the difference between red and green is 40% in the green, and the sum of the red and green intensities is 120%.

The normalized value will be 40% / 120% or 0.33, which is converted back to percent values of 33% for display purposes.

The displayed color for that pixel will have RGB values of 0%, 33%, 0%.

Compare this value to another pixel that has RGB values of 0%, 40%, 20%. The normalized difference is 40% / (0% + 40%) which equals 1. This value is converted back to a percentage of 100%. The pixel will be displayed with an RGB value of 0%, 100%, 0%.
To see the RGB digital image while using another visualization scheme, click on 'Show Original Image' and a window with the RGB image will appear.

You may drag this image to any position on the computer screen, and you may use the point, line, and area on this image as well as the enhanced image displayed on the larger window.

Information on the Mask Display Feature
This features allows you to control and quantify the visualize relationships between color intensities for each pixel in the image.

You may either select a range of values to highlight (such as highlight the red intensities between 50 and 75%) or relative intensities between two sets of measurements (such as highlight the red values that are greater than the green values by 10 units of intensity).

Values that meet the criteria you select are colored in "Black" and values not meeting the criteria are colored in "White."

To select a category to mask, either click any of the three check boxes next to Red, Green, or Blue or use the small arrows to change the maximum or minimum values associated with each category.

If you select more than one category, the mask that is generated requires all criteria to be met. So if you create a mask with red between 50-75% and green between 25-60%, the pixels in black will be have red between 50 & 75% AND green between 25 & 60%.

Setting criteria for a relative relationship between intensity values requires you to select different intensities in the equation (you cannot compare red to red, for instance).

If you select a relationship "Red = Red + 10", a message will pop up requesting you to select non-matching variables. A valid relative relationship would be "Red = Green + 10".

The "+/-" option acts as a filter that allows you to set the range of value when you are using the "=" option.

For example, the relationship "Red = Green +/- 20" will create a mask showing pixels with red intensity greater than or equal to Green - 20 and less than or equal to Green + 20.

To apply the relationships, click 'Mask Image using Thresholds set Above'.

The criteria you have selected will be summarized in text below the image of the masked pixels.

Tools forAnalyzing Digital Images
Select one of three tools to analyze the image.

1) The point tool examines the intensities of red, green, and blue measurements at a pixel within the image.

2) The line tool displays the color intensities for each pixel along a line.

3) The area tool calculates the frequency of occurrence of color intensities of pixels within the selected area.

To use each tool, click the cursor at some point within the image, and drag the cursor to obtain the desired point, line, or rectangular area.

Information of the pixel(s) at the point, along the line, or within the area will be automatically calculated and graphically displayed.

Values of color intensity are scaled from 0 to 100%.

To move the crosshair, line, or area drawn on the image, use the small up and down arrows that are along the right edge of the satellite image.

Use these arrows to create a point, line, or area as well.

Information on the Histogram Tool
This feature is similar to the results generated using the area analysis tool, except that the resulting graph is based on the entire digital image rather than a selected area.
A histogram is a frequency distribution (or number of times a value falls within a certain range) of pixels within the picture is graphed in a floating window.

An average of the color intensities displayed on the left edge of the graph.

Since this is a floating window, you may compare the results of the area tool to see how representative it is compared to the entire image.

You may control the data that is displayed by using the 'on'/'off' buttons located at the bottom of the floating window.

Information on Graph Tools

When you generate a graph using the line or area analysis tools, you have the option to display the color intensities of selected pixels of the picture.

By clicking on the button labeled 'On' adjacent to either Red, Green, or Blue text, you can hide the particular information.

In the case of the line tool, you are hiding or displaying the color intensities of pixels along the selected line starting at the blue dot and ending at the red dot.

An average of the intensities of the pixels along the selected line is displayed on the left edge of the graph.

For the area tool, the frequency distribution (or number of times a value falls within a certain range) of pixels falling within the selected area (box) is graphed in the lower right area of the window.

An average of the color intensities of all the pixels within the area is displayed on the left edge of the graph.

Page Setup and Print

To print the images and graphs, first use 'PageSetup' in the File Menu.

Select 'landscape' printing and experiment with the scale for a full page print (a scale of 70% works on our printers).

Saving Images

To save a visualization of the satellite image, use the 'Save Image' option located in the 'File' menu.

NOTE: do NOT use the same name as the original satellite image since the saved image will overwrite any file with the same name that already exists.

FalseColor

Purpose: This program is virtually identical to the ColorPicture software, except that it is designed to display jpegs of Landsat images available on the United States Geological Survey’s Earthshots website: http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents

Rather than controlling the image’s red, green, and blue being displayed by the computer display, the software displays the intensities of the satellite measurements for each pixel.

In this case, the data being displayed is the infrared, visible red, and visible green measurements by the Landsat satellite.
SurfaceType

Purpose: Explore the reflection characteristics of infrared and visible red and green of different materials of the Earth’s surface.

Getting Started

Click ‘Select Satellite Image’ to choose a satellite picture to examine.

A window will pop up to allow you to select any image saved on the computer.

Change the visual enhancement (or visualization) of the satellite image by clicking the pop up menu labeled ‘Satellite Image Visualization’.

Images will first be displayed as a typical Landsat Image with the infrared data in the computer’s red color and the visual red and green light mapped by the computer’s green and blue colors, respectively.

Separate satellite sensor measurements may be visualized with the remaining options that either use the computer color typically associated with the sensor data or in shades of gray.

There are two analysis tools.

The pixel analysis tool displays the intensities at each pixel on the satellite image as you click and drag the cursor across the image.

A crosshair appears on the screen to highlight the cursor’s location.

The numerical values represent the intensity of a narrow bands of reflected light from the Earth’s surface.

Intensity values are scaled from 0 to 100%.

Use the arrows next to the x and y pixel positions to move the crosshairs incrementally across the image.

Explore the characteristics intensities associated with different surface features.

The line analysis tool lets lines be drawn on the image in order to calculate the size of surface features.

To begin a line, click the cursor on the image and hold the mouse key down as you drag the cursor across the image.

When you release the mouse key, the line stops changing.

Use the arrows next to the x and y start and stop positions to incrementally change the position of the line.

The pixel length of the line can be converted to distances using the scale provided at the lower right of each satellite image.

There are 13 visualizations to view the satellite image.

1) Standard color composite of Landsat imagery in which the intensity of the infrared measurements are displayed in the computer display’s red, the visible red displayed in the computer’s green, and the visible green displayed in the computer’s blue.

2-7) IR, Red, or Green (Color or Gray). A color or gray shade image of only one set of satellite measured intensities.

For example, a gray shade image of IR displays the pixel’s IR value in all three colors of the computer’s display.

Gray shade images allow you to examine the intensities of values without biasing your sensitivity to red, green, or blue.

Use the color version to illustrate the contribution of the satellite measurements to the standard color satellite image since the IR is shown in red, and so on.
8-10) IR v R, IR v G, or R v G: For each pixel, display the difference between two listed satellite measurements.

The associated color of the greater value is displayed: IR is displayed as a shade of gray, Red as red, and Green as green.

For example, using IR v R, if a pixel has 20% IR, 85% Red, and 65% Green, the difference is 65% to be displayed in the computer’s Red.

The brighter the color displayed, the greater the difference between the two measurements; and the darker the color (or closer to black), the smaller the difference between the two measurements.

11-13) Normalized versions of IR v R, IR v G, or R v G: Used to visualize the difference between two sets of satellite measurements, the basic formula is \( \frac{\text{Intensity}_A - \text{Intensity}_B}{\text{Intensity}_A + \text{Intensity}_B} \).

This formula tends to minimize difference in illumination of the surface caused by clouds and slope of the land surface.

The color scheme is similar to those used in 8-10: shades of gray are used to indicate where IR is greater, red where Visible Red is greater, and green where Visible Green is greatest.

X/Y Locations

Moving the cursor, line, or rectangle with the control buttons can be confusing unless you understand the mapping of X and Y on the satellite image.

The size of these satellite images is 451 pixels wide and 325 pixels high.
The upper left corner is (0,0) - this is very important to remember!
X controls the horizontal location of the cursor, and the maximum value on the screen is 450 (0 indicates the left edge and 450 the right edge, so 451 pixels make up each row of the image).
Y controls the vertical location of the cursor, and the value of the upper edge is where Y=0. The lower edge has Y=324.

LandSatAnalysis

**Purpose:** This program is virtually identical to the ImageAnalysis software, except that it is designed to display only jpegs of Landsat images available on the United States Geological Survey’s Earthshots website: [http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents](http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents)

Therefore, rather than controlling the image’s red, green, and blue being displayed by the computer display, the software displays the intensities of the satellite measurements for each pixel. In this case, the data being displayed is the infrared, visible red, and visible green measurements by the Landsat satellite. In addition, calculations automatically include the Normalized Difference Vegetation Index.

Getting Help

There are many useful features to this program, and additional information is available in the ‘Help’ menu.

Getting Started

First, click ‘Select Satellite Image’.

At any time you may select a new satellite image by clicking on the ‘Select New Satellite Image’ button.

Whenever you select a new image, all feature values are reset to default values.

After the image is selected, a window will pop up that asks you to enter the numerical value of the map scale value visible in the lower left corner of each satellite image.

If you make a mistake, click ‘Calibrate Distance/Area Tool’.
Select Method of Scale Calibration

A window pops up to request the scale of the small white square in the lower left corner be entered.

NOTE that if there is considerable white around the box that is part of the satellite image, the automated calibration may become confused. Check the results by measuring the scale box with the line tool. If incorrect, rerun the calibration (click ‘Calibrate Distance/Area Tools’ and select the ‘Scale Present in Image’ calibration method.

The program assumes that the pixels are square in shape so measuring the distance in one direction is applied to all directions.

Page Setup and Print

To print the images and graphs, first use ‘PageSetup’ in the File Menu. Select ‘landscape’ printing and experiment with the scale for a full-page print. We have found that a scale of 70% works on our printers.

Saving Images

To save a visualization of the satellite image, use the ‘Save Image’ option located in the ‘File’ menu.

NOTE: do NOT use the same name as the original satellite image since the saved image will overwrite any file with the same name that already exists.

Exploring Satellite Images

Use the pop up menu button below the text ‘Display Tools’ to toggle between different displays of the satellite image.

There are 13 automatically calculated enhancements to view the satellite image.

1) RGB = standard color composite of Landsat imagery in which the intensity of the infrared measurements are displayed in the computer display’s red, the visible red displayed in the computer’s green, and the visible green displayed in the computer’s blue.

2) B&W = black and white image of the RGB image in which the average of the intensity values the image’s infrared and visible red and green is displayed equally in the computer display’s red, green, and blue.

3) NDVI (Normalized Difference Vegetation Index). Displays a color-coded scale of vegetation cover. For more information, see the section on Normalized Difference Vegetation Index that follow this section.

4) Mask. A combination visualization/display enhancement and image analysis tool. Allows you to create ways to display pixels that meet thresholds you select. Pixels meeting criteria are displayed as black. White pixels represent those that did not meet the criteria.

5-7) IR, Red, or Green (Gray). A gray shade image of only one set of satellite measured intensities. For example, a gray shade image of IR displays the pixel’s IR value in all three colors of the computer’s display.

Gray shade images allow you to examine the intensities without biasing your sensitivity to red, green, or blue.

8-10) IR v R, IR v G, or R v G: For each pixel, display the difference between two listed satellite measurements. The associated color of the greater value is displayed: IR is displayed as a shade of gray, Red as red, and Green as green.

For example, using IR v R, if a pixel has 20% IR, 85% Red, and 65% Green, the difference is 65% to be displayed in the computer’s Red. The brighter the color, the greater the difference between the two measurements, and the darker the color (or closer to black), the smaller the difference between the two measurements.
11-13) Normalized versions of IR v R, IR v G, or R v G: Used to visualize the
difference between two sets of satellite measurements, the basic formula is

\[
\frac{(\text{Intensity}_A - \text{Intensity}_B)}{(\text{Intensity}_A + \text{Intensity}_B)}
\]

This formula tends to minimize difference in illumination of the surface
caused by clouds and slope of the land surface.

The color scheme is similar to those used in 8-10: shades of gray are
used to indicate where IR is greater, red where Visible Red is greater,
and green where Visible Green is greatest.

Click ‘Show Original Satellite Image’ and a box with the RGB image will appear.

Drag this image to any position on the computer screen

Use the point, line, and area on this image as well as the enhanced
satellite image displayed on the larger window.

**Normalized Difference Vegetation Index**

A Vegetation Index is a measure of the amount of vegetation covering the
Earth’s surface.

Healthy vegetation absorbs visible light, especially red light, and reflects
much of the infrared.

A simple Vegetation Index is based on the difference between these
intensities.

Another index, NDVI, provides more consistent identification of
vegetation.

NDVI stands for “Normalized Difference
Vegetation Index”, which means that the
difference between the intensities of the
reflected infrared and visible red light are
divided by the sum of the intensities of the two
light measurements.

This mathematical manipulation
compensates for areas experiencing hazy
sunshine compared to those in clear skies.

Dense, healthy vegetation produces NDVI
values near +1.0.

Bare soil and rock reflect similar levels of
infrared and red light, so these surfaces
produce NDVI values near 0.

Clouds, water, and snow reflect more visible
light than infrared, which is the opposite of
vegetation, and so produce NDVI values near
-1.0.

**Information on the Mask Display Feature**

Tool for visualizing and quantifying the
relationships between intensities of infrared and
visible red and green for each pixel in the image.

You may either select a range of values to
highlight (such as highlight the IR intensities
between 50 and 75%) or relative intensities
between two sets of measurements (such
as highlight the IR values that are greater
than the green values by 10 units of
intensity).

Values that meet the criteria you select are
colored in “Black” and values not meeting
the criteria are colored in “White.”

To select a category to mask, either click
any of the four check boxes next to IR, Red,
Green, or NDVI (a technique that estimates
vegetation cover within the pixel) or use
the small arrows to change the maximum
or minimum values associated with each
category.

If you select more than one category, the
mask that is generated requires all criteria
to be met.

A mask with IR between 50-75% and Red
between 25-60%, creates black pixels that
have IR between 50 & 75% AND red between
25 & 60%.

Setting criteria for a relative relationship
between intensity values requires you to
select different intensities.

If you select a relationship “IR = IR + 10”, a
message will pop up requesting you to select
non-matching variables.
The "+/-" option acts as a filter that allows you to set the range of value when you are using the "=" option.

For example, the relationship "Red = Green +/- 20" will create a mask showing pixels with red intensity greater than or equal to Green-20 and less than or equal to Green+20.

To apply the relationships you have created, click the button "Mask Satellite Image using Thresholds set Above".

The criteria you have selected will be summarized in a text box below the image of the masked pixels.

**Tools for Analyzing Satellite Images**

Select one of three tools to analyze the satellite image.

1) The *point* tool examines the intensities of electromagnetic measurements at a pixel within the image.

2) The *line* tool displays the satellite measurements for each pixel along a line.

3) The *area* tool calculates the frequency of occurrence of intensities of pixels within the selected area.

To use each tool, click the cursor at some point within the satellite image, and drag the cursor to obtain the desired point, line, or rectangular area.

Information of the pixel(s) at the point, along the line, or within the area will be automatically calculated and graphically displayed.

Another way to move the analysis tools around a satellite image is to use the small up and down arrows that are along the right edge of the locations of the point, ends of line, or corners of the area.

Use these arrows to create the point, line, or area.

**Information on the Histogram Tool**

This feature is similar to the results generated using the area analysis tool, except that the resulting graph is based on the entire satellite image rather than a selected area.

A histogram is a plot of the frequency distribution (or number of times a value falls within a certain range) of pixels within the satellite image is graphed in a floating window.

An average of the intensities and/or vegetation analysis of the pixels is displayed on the left edge of the graph.

Since this is a floating window, you may compare the results of the area tool to see how representative it is compared to the entire image.

You may control the data that is displayed by using the ‘on’/‘off’ buttons located at the bottom of the floating window.

**Information on Graph Tools**

When you generate a graph using the line or area analysis tools, you have the option to display the values associated with the measurements and vegetation index of selected pixels of the satellite image.

Click on the button labeled ‘On’ adjacent to the IR, Red, Green, or NDVI text in order to turn on and off particular graphical information.

In the case of the line tool, you are hiding or displaying the values of pixels along the selected line starting at the blue dot and ending at the red dot.

An average of the intensities and/or vegetation analysis of the pixels is displayed on the left edge of the graph.

For the area tool, the frequency distribution (or number of times a value falls within a certain range) of pixels falling within the selected area (box) is graphed in the lower right area of the window.

An average of the intensities and/or vegetation analysis of all the pixels within the area is displayed on the left edge of the graph.
VegetationAnalysis

**Purpose:** This program is similar to the LandSatAnalysis software, but now you may explore a time series of 2 or 3 Landsat images side by side.

You may display only jpegs of Landsat images available on the United States Geological Survey’s Earthshots website: [http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents](http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents). This web site has created satellite images over the exact area but separated by months or years, which allow you to examine how the Earth’s vegetation responds to natural and human-induced changes in the environment, such as Mt. St. Helens and Chernobyl.

Getting Help

There are many useful features to this program, and additional information is available in the ‘Help’ menu.

Getting Started

First, TYPE the number of satellite images to work with in the white box above. This number must be either 2 or 3.

Next, click ‘Select Satellite Images’.

Select a series of 2 or 3 satellite pictures.

Pick the earliest (oldest) picture first, followed by the next oldest, and the most recent image last.

You will not be allowed to continue if you pick images that are not of the same area or not in increasing year.

After images are selected, a window will pop up that asks you to enter the numerical value of the map scale value visible in the lower left corner of each satellite image.

Exploring Satellite Images

Use the ‘Change Enhancement’ button to toggle between an RGB picture and a NDVI enhancement.

All satellite pictures will have the same enhancement.

**Page Setup and Print**

To print the images and graphs, first use ‘PageSetup’ in the File Menu. Select ‘landscape’ printing and experiment with the scale for a full-page print. We have found that a scale of 75% works on our printers.

Tools for Analyzing Satellite Images

Select one of three tools to analyze the satellite images. Information from each of satellite image will be automatically calculated and displayed.

1) **Point Analysis Tool**

Explore the the vegetation index (NDVI) at each pixel of the satellite images.

Compare the values at the same location on each satellite image.

Move the cursor around a satellite image in three ways:

1) Click the mouse on an area of interest,
2) Click and drag the mouse to an area of interest,
3) Use the small up and down arrows along the upper-right edge. These arrows become visible when you select a Point Tool. Additional arrows appear when you select a Line or Area Tool. Use these arrow controls to move the end points of lines or the opposing corners of a rectangle drawn on the images.

2) **Line Analysis**

Place the cursor in a satellite image, click and drag the cursor to draw a line.

NDVI values for pixels along the line are graphed.

The start and end of the line are color-coded (blue start, red stop).

An average NDVI of pixels along the line are calculated and color-coded by the year of each image.
Move the cursor to each satellite image to see individual lines of yearly data on the graph.

3) Area Analysis
Place the cursor in a satellite image, click and drag the cursor to draw a rectangle.
NDVI values for pixels inside the rectangles are used in calculations.
If min/max NDVI values are -1 and 1, respectively, a histogram of NDVI values within the rectangle are plotted.
By changing the min/max values, the percent of NDVI values between the selected range is displayed.
As with the line tool, move the cursor to each satellite image to see individual lines of yearly data on the graph.

Normalized Difference Vegetation Index
A Vegetation Index is a measure of the amount of vegetation covering the Earth’s surface.
Healthy vegetation absorbs visible light, especially red light, and reflects much of the infrared.
A simple Vegetation Index is based on the difference between these intensities.
Another index, NDVI, provides more consistent identification of vegetation.
NDVI stands for “Normalized Difference Vegetation Index”, which means that the difference between the intensities of the reflected infrared and visible red light are divided by the sum of the intensities of the two light measurements.
This mathematical manipulation compensates for areas experiencing hazy sunshine compared to those in clear skies.
Dense, healthy vegetation produces NDVI values near +1.0.
Bare soil and rock reflect similar levels of infrared and red light, so these surfaces produce NDVI values near 0.
Clouds, water, and snow reflect more visible light than infrared, which is the opposite of vegetation, and so produce NDVI values near -1.0.
Acknowledgements

We would like to thank the talented people who have reviewed the written materials, software activities, and/or hands-on activities. Their insightful comments and suggestions have been incorporated in this version.

Staff at the Museum of Science

Visiting at the Museum of Science
Steve McDonald, UMASS Boston; Candace Julyan, Educator; Kathy Cunningham and Matt Amengual, GIS specialists; Momcilo Babic, Plant Geneticist; Beth Nicholson, Chairperson, Save the Harbor, Save the Bay; Teon Edwards, Remote Sensing Specialist at TERC; Crystal Schaaf, Remote Sensing Scientist, Boston University; Bill Lawler, education specialist in technology and computers; Dona Gartrell, President of The Learning Community Group; Don McCasland, Educator, Blue Hill Observatory, Milton, MA; Abbie Nguyen, Fenway High School, MA; Jack Sheridan, Science Supervisor for Boston Public Schools; Jodi Davenport, PhD student in Perception, MIT; and Mary O’Connor, Environmental Defense Fund.

Maine Teachers through the Maine Mathematics and Science Alliance, Augusta, Maine

Remote Sensing Specialists, Atmospheric and Environmental Research, Inc., Lexington, MA
Gary Gustafson, Robert D’Entremont, Jennifer Hegarty, Alan Lipton, Mark Leidner, and Rick Rosen.
A devastating nuclear accident happened at Chernobyl, Ukraine, on 26 April 1986. These images show the area around the nuclear power plant approximately one month after the accident, and six years after the accident. This area is near the common borders of Ukraine, Belarus, and Russia.

The images clearly show farm abandonment. Agriculture appears as a collage of bright red (growing crops) and white (highly reflective bare ground). Many of these areas appear a flat tan-green in 1992, indicating natural vegetation which has taken over the abandoned fields. While the reactor was still on fire, all settlements within 30 km were evacuated, including Pripyat (1986 population 45,000), Chernobyl (1986 population 12,000), and 94 other villages (estimated total population 40,000). As of 1992, this area remained almost completely abandoned.

The radiation also affected wild plants and animals around Chernobyl. Pine forests soon died, cattails grew three heads, and wild animals declined in number. But in the coming years, as the short-lived radionuclides decayed and the longer-lived contaminants settled deep into the soil, the wildlife rebounded. Human abandonment also made habitat available for birds, deer, rodents, wolves, boar and other animals. These populations appear to be increasing despite the extraordinarily high mutation rates caused by contamination in the food chain and by one of the highest background radiation levels in the world.3

Satellite images

http://edcwww.cr.usgs.gov/earthshots/slow/tableofcontents

These images show the rapid growth of Las Vegas, Nevada. This is by far the fastest-growing metropolis in the United States. The population has grown in recent decades as follows:

1964: 127,000 1986: 608,000
1972: 273,000 1992: 863,000 1997: 1,124,000

These are the same kind of standard false-color images that appear throughout Earthshots, simulating color-infrared aerial photographs. Remember “RGB = NRG”: red, green, and blue in the image represent how much near-infrared, red, and green solar energy the ground reflects.

As the city expands you can see a sort of landcover succession through human construction.

- Pre-construction land appears medium gray-green indicating sparse desert vegetation, reddish soils, and stone.
- Construction land appears brighter. Bulldozed soil, bare of vegetation, is very reflective.
- A young neighborhood appears medium green (medium green) again, perhaps a bit brighter from all the reflective pavement and roofs. The trees are small, and some developments now conserve water by landscaping with rock and desert plants rather than grass.
- An old neighborhood appears dark, brownish red, from the mature trees and more grass.
- Golf courses appear bright red because they are the most intense vegetation.
- Water appears almost black because at this angle it scatters little light back to the Landsat sensor.

Satellite images

The 1972, 1986 and 1994 scenes are from the NALC dataset.

LM1042035007225790 (Landsat 1 MSS, 13 September 1972)
LM5039035008625390 (Landsat 5 MSS, 10 September 1986)
LM5039035009225490 (Landsat 5 MSS, 10 September 1992)